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メイン画面のあらまし 
LX Navi プログラムが起動するとメイン画面が表示されます。 

メニューバー ツールバー ステータス表示 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

記録モード(REC)/再生モード(VIEW)の切り替

え、記録ファイル名の確認、再生するファイルの

選択などができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

メニューバー 

New: データを記録するデバイス
の選択、ファイル名の指定 

Open: 再生データの選択 
Copy: データのコピー 
Format: メディアのフォーマット 
Exit: アプリケーションの終了 

System: 動作、記録条件、再生条件の設定
Trigger: トリガ動作の設定 
Params: Property: 設定の保存、読み込み

Toolbar： ツールバーの表示、消去 
Status Bar： ステータスバーの表示、消去
Bar： バーグラフの表示、消去 
Digit： ディジタル値の表示、消去 
Hdr： ヘッダ情報の表示、消去 

波形表示エリア 
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ツールバー 

ステータス表示 

File → New 

File → Open 

File → Copy 

Setup → System

Setup → Trigger 

Setup → Params Property 

TEDS情報読み込み［4-11］

オートオフセット［4-13］ 

キャリブレーション［4-14］ 

スキップの設定 

前にスキップ 

後にスキップ 

停止 

記録スタンバイ 

開始 

一時停止 

イベントマーク 

イジェクト 

ファンの強制停止［5-19］ 

データを音で再生する［5-19］ 

View → Bar 

View → Digit 

キャリブレーションの実行 

View → Hdr 

ゼロバランス［4-15］ 

ファン停止の残り時間 

モード表示、記録時は RECORD、 

再生時は View 
現在の日時、再生モード時は記録日時 イベントマーク数 

動作状態 

STOP: アイドル状態 

RECSTANDBY: 記録待機状態 

REC: 記録中 

PLAY: 再生中 

PAUSE: 再生一時停止中 

経過時間 
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記録・再生のながれ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

再生モードになる 

LX Navi 起動 

記録 
File, New 

再生 
File, Open 

記録デバイス、ファイル名指定 

記録モードになる 

記録の操作 

メモリー記録停止後、メディアまたは PC に保存 

再生ファイル選択 

メモリー記録が 

選択された場合 

再生の操作 
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システムの設定 
Setup メニューから System を選択して LX本体の動作を設定します。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sample 
サンプリング周波数を選択します。上段で設定したいサンプリング周波数が含まれるサンプリング周波数系列を選択し、

下段で表示されるサンプリング周波数を選択します。選択可能なサンプリング周波数は、選択された記録メディア、タコメ

ーター入力チャネルモードの選択により制限を受けます。「1-13 サンプリング周波数とチャネル数」を参照して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

LX-10/10L の場合 

LX-10/10L では、上段では<96k-1.5k>のみ選択可能で、下段で設定できるサンプリング周波数は 96 kHz、48 kHz、24 

kHz、12 kHz、6 kHz、3 kHz、1.5 kHz のいずれかとなります。 

LX-20/20L の場合 

LX-20/20L では、<96k-1.5k>以外に、<100k-1k> (100 kHz、50 kHz、20 kHz、10 kHz、5 kHz、2 kHz、1 kHz から選

択)、<102.4k-1.28k> (102.4 kHz、51.2 kHz、25.6 kHz、12.8 kHz、5.12 kHz、2.56 kHz、1.28 kHz から選択)、

<65.536k-1.024k> (65.536 kHz、32.768 kHz、16.384 kHz、8.192 kHz、4.096 kHz、2.048 kHz、1.024 kHz から選択)

の 4 つのサンプリング周波数系列の中から選択できます。 

低速サンプリング対応アンプの場合 

低速サンプリングに対応したDC入力アンプカードまたはＳＴアンプカードがインストールされている場合は、<1k-1/60>が表

示され、1 kHz、500 Hz、200 Hz、100 Hz、50 Hz、20 Hz、10 Hz、5 Hz、2 Hz、1 Hz、1/2 Hz、1/5 Hz、1/10 Hz、

1/30 Hz、1/60 Hz のいずれかの選択が可能です。 

サンプリング周波数の設定 

パネルロック 

記録中にファンを止める 

メモ音声を録音する 

時計合わせ 

モニター出力と 

ジェネレータ出力の設定 

スロット 1の使用チャネル数の設定

スロットを有効にする 

タブ表示を移動 

キャリブレ-ション 

ＳＴアンプの設定時にゼロバランスを自動的に行う。 

REC STANDBY 時に PC の時刻に合わせる。 

変更したチャネル

以降のチャネル設

定を同様にする 
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Memo 
メモ音声を録音、再生するときは<ON>に設定して下さい。メモ音声のデータはWAV ファイルとしてデータファイル、ヘッダファイルと

は別に記録され、毎秒 8,000 バイトです。このデータはマイクロホンをジャックから抜いても増えますので、ご注意下さい。 

 

■ プリトリガ期間中はメモ音声は録音されません。また、再生時はメモ音声の先頭とデータの先頭とが一致して再生されます

ので、タイミングがずれます。 

 

 

 

 

 

■ PC(のみ)記録時にメモ音声を録音する場合は、停止する前に     をクリックするか本体の PAUSE ボタンを押して、いった

ん記録一時停止状態にして下さい。 

 

Fan 
<OFF>に設定すると記録開始から10分間だけLX本体の冷却ファンを止めることができます。騒音などを記録する場合に便利

です。一度ファンを止めて記録したら、次にまたファンを止めて記録するまでは約 10 分間以上時間をおいて下さい。 

<ON>に設定した場合、冷却ファンは動作しますが、ツールバーの FAN 強制停止ボタンをクリックすると、記録中にファンを強制

的に停止することができます。もう一度クリックするとファンは動作します。ファンを停止できる時間は、一つの記録開始から停止

までで、合計 10 分間で、<ステータス表示>に残り時間が表示されます。(「3-3 メイン画面のあらまし ツールバー・ステータス表

示」参照) 

 

Panel 
<Lock>に設定すると、本体のフロントパネルの操作ボタンを無効にすることができます。 

 

Calibration 
<ON>に設定すると本体の電源を立ち上げ時に、自動的にキャリブレーションを実行します。 

 
Clock 
本体の内蔵時計を修正します。ここには内蔵時計による現在日時が表示されています。日付を変更するには、日付の右の▼

をクリックするとカレンダーが現れますので、希望の日付をクリックして選んで下さい。時刻を変更するには、変更したい桁をクリック

して反転させてから数をタイプするか、右の▲、▼をクリックして数を増減させて下さい。最後に時報に合わせてSetをクリックする
と、その瞬間に時計が修正されます。 

PC をクリックすると、接続された PC の時刻が LX 本体にセットされます。 
 

Slot Use 
記録、再生に使用するスロットをチェックして有効にして下さい。Slot 1 に対しては、記録に使うチャネル数を 2、4、8 チャネルから

選択することができます。 

ここで有効にした各スロットにインストールされた入出力アンプの設定は、System ダイアログの各スロットのタブをクリックして行い
ます。 

LX-20/20L でタコメーターパルス入力チャネルを有効にするには、Tacho をチェックして下さい。 
 

■ タコメーターパルス入力とジェネレータ出力機能を同時に使用することはできません。 

 

Same Setting 
アンプの各チャネルの設定をする場合、ボックスをチェックすると設定チャネル以下のチャネルも同一の内容が設定されます。 

 

データ再生 

音声再生 

プリトリガ 
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Auto Zero Balance 
ＳＴアンプが装着されている場合、ボックスをチェックすると設定終了後に自動的にゼロバランスを実行します。 

 
Adjust to PC Clock Before REC STANDBY 
ボックスをチェックすると REC スタンバイ時にＰＣの時刻に本体の時刻を合わせます。 

 
Monitor/Generator 
Signal では背面の MON OUT コネクタから出力するモニターチャネル、または、ジェネレータ出力信号(LX-20/20L の場
合のみ)を選択します。出力しない場合は<NONE>に設定して下さい。 

Property をクリックして、モニターチャネルの出力レンジや、ジェネレータ出力の詳細設定を行います。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Signal では、モニターチャネルの選択、または、ジェネレータ出力信号の種類(LX-20/20L のモニター出力より sine、
sweep sine、pulse、pink noise、または white noise を出力することができます。) を選択することができます。 

ジェネレータ出力が選択された場合、このダイアログで設定できる内容は下記となっています。(選択された信号種類によ

り設定できる内容が自動的に選択されます。) 

Sin/Sweep 
Start Freq: Signal で<sine>、<sweep sine>が選択されたときの開始周波数(Hz)を設定します。 
Stop Freq: Signal で<sweep sine>が選択されたときのスイープ終了周波数(Hz)を設定します。 
Rate: Signal で<sweep sine>が選択されたときのスイープレートを設定します。 

Pulse 
Pulse Width: Signal で<pulse>が選択されたときのパルス幅を設定します。 
Pulse Interval: Signal で<pulse>が選択されたときのパルスインターバルを設定します。 

 

Range では出力レンジを設定します。レンジは 1 V から 5 V まで 0.1 V ステップで選択することができます。 
 

ジェネレータ出力の仕様については、6 章を参照して下さい。 

 

■ タコメーターパルス入力とジェネレータ出力機能を同時に使用することはできません。 

 

■ 低速サンプリングモード(1 kHz ～ 1/60 Hz)で記録時、モニター出力からのアナログ出力は使用できません。 
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入力アンプの設定 
System ダイアログで、入力アンプが取り付けられているスロットのタブをクリックして入力アンプの設定を行います。 
各スロットに取り付けられているアンプの種類により設定内容が異なります。 

 

DC アンプ AR-LXDC/DC2 
Slot タブに<DC-8>と表示されます。 
AR-LXDC2 は、低速サンプリングに対応した DC 入力アンプで、AR-LXDC に 1 kHz ～ 1/60 Hz のサンプリング周波数が追

加された入力アンプです。 

アンプの仕様については、6 章を参照して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

レンジの設定 

±0.5、1、2、5、10、20、50 V から選択できます。AD 変換値は選択したレンジの±131%の範囲をとり得ますが、入力余裕度

は約±120%です。入力が±120%を超えないようにレンジを選択して下さい。信号を入力し、右の  ボタンをクリックしてレベル

を確認しながら設定して下さい。 

 

Auto 
信号を入力してクリックすると自動的に最適な入力レンジに設定することができます。 

 

■ 低速サンプリングモード(1 kHz ～ 1/60 Hz)で記録時、アナログ出力アンプおよびモニター出力からのアナログ出力は使用

できません。 

■ 低速サンプリングモード(1 kHz ～ 1/60 Hz)で記録されたデータファイルのアナログ再生は、1.5 kHz 以上のサンプリング設定

に変更して行うことができます。 

 

 

入力レンジの選択 

入力レベルを確認する 

全チャネルの入力レベルを確認する 

入力レベルの確認を止める 

入力レンジを自動的に設定する 
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PA アンプ AR-LXPA1/PA3 
LX シリーズには、2 種類の PA アンプ 電圧出力型加速度センサ入力アンプが用意されています。 

AR-LXPA1 の場合は、Slot タブに<PA-8>と表示されます。 
AR-LXPA3 の場合は、Slot タブに<PA3-8>と表示されます。 
AR-LXPA3 は、AR-LXPA1 に±50 V 入力レンジと A特性/C特性フィルタの追加された入力アンプです。 

アンプの仕様については、6 章を参照して下さい。 

 

PA アンプ使用上の注意 

 

■ キャリブレーション 

入力レンジ 0.01 V で測定される場合は、測定を始める前に 10 分間以上ウォームアップしてからマニュアルキャリブレーショ

ンを実行することをおすすめします。キャリブレーションを実行するには付属ソフト LX Navi でツールバーの     ボタンをクリ

ックします。これにより、高精度の測定が可能となります。高精度測定を行うときは、平衡モードで測定することをおすすめ

します。 

 

■ 接続・接地について 

バッテリー動作の回路信号や多くのトランスデューサを使用する場合 

入力モード: 平衡（Bal）モード 

LX 本体のフレームグランド（FG）をできるだけ接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

交流電源で動作の回路信号（AC、ICP、DC）を使用する場合 

入力モード: 平衡（Bal）モード 

入力信号源のフレームグランド（FG）と LX 本体のフレームグランド（FG）を必ず接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

AR-LXPA 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 

AR-LXPA 

GND 
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交流電源で動作の回路信号（DC）を使用する場合 

入力モード: 不平衡（Unbal）モード 

入力信号源のフレームグランド（FG）を接地した場合は、LX 本体のフレームグランド（FG）は接地しないで下さい。 

 

 

 

 

 

 

 

 

 

 

 

交流電源で動作の回路信号（DC）を使用する場合 

入力モード: 不平衡（Unbal）モード 

入力信号源のフレームグランド（FG）がない場合は、LX 本体のフレームグランド（FG）を接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 

AR-LXPA 

AR-LXPA 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 
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AR-LXPA1 設定画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-LXPA3 設定画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bal/Unbal: Unbal が選択されると、DC OFF FLAT の選択のみ有効です。 
 

■ AR-LXPA3 アンプの場合、センサ供給電源 28 V DC/24 V DC の切り替えは、アンプカード内部のディップスイッチに

て行います。標準では 28 V DC の設定となっています。24 V DC への設定に関しては、弊社までお問い合わせ下さい。 

ウェイティングの選択を行います。 

A: A 特性 

C: C 特性 

FLAT: フラット 

HPF 選択を行います。 

OFF: なし 

10Hz: 10 Hz 

20Hz: 20 Hz 

入力レンジを選択します。(0.01 V、0.0316 V、0.1 V、

0.316 V、1 V、3.16 V、10 V) 

AC 結合か DC結合かを選択します。 

AC: AC 結合 

DC: DC 結合 

センサに電源を供給するか否かを選択します。 

OFF: 供給しない 

4mA: 4 mA の定電流を供給する 

平衡/不平衡モード選択 

Bal: 平衡 

Unbal: 不平衡 

不平衡モードのときは 8 チャネルすべて

DC結合となります。 
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ST アンプ AR-LXST1 
Slot タブに<ST1-8>と表示されます。 
AR-LXST1 は、歪みゲージおよび歪みゲージタイプの各種センサと DC電圧に対応した入力アンプです。 

アンプの仕様については、6 章を参照して下さい。 

 

ST アンプ使用上の注意 

 

■ キャリブレーション 

測定を始める前に5分間以上ウォームアップしてからマニュアルキャリブレーションを実行することをおすすめします。キャリブレーショ

ンを実行するには付属ソフト LX Navi でツールバーの     ボタンをクリックします。これにより、高精度の測定が可能となります。 

 

■ 接続・接地について 

トランスデューサを使用する場合 

入力モード: 平衡（Bal）モード 

LX 本体のフレームグランド（FG）をできるだけ接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

交流電源で動作の回路信号（DC）を使用する場合 

入力モード: 平衡（Bal）モード 

入力信号源のフレームグランド（FG）と LX 本体のフレームグランド（FG）を必ず接地して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AR-LXST1 

AR-LXST1 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 

GND 

FG 

Vs 

- 

+ +

- 

LX 本体 

GND 
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AR-LXST1 設定画面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

入力レンジを選択します。 

右下の uST をクリックするとmV/V表示に切り替わります。 

入力レンジ表示を切り替えます。 

uST ⇔ mV/V 

ブリッジ電圧を切り替えます。 

OFF にすると DC電圧の入力レンジ設定ができます。 

ローパスフィルタの設定を行います。 
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TEDS 機能を利用した感度設定 
AR-LXPA1/AR-LXPA3 アンプに、IEEE Std 1451 A SMART TRANSDUCER INTERFACE に準拠したトランスデューサが接

続された場合、そのトランスデューサの Transducer Electronic Data Sheet (TEDS)と呼ばれる個別情報を読み取り、情報の

表示や感度係数の設定を自動的に行うことができます。 

 

■ トランスデューサ情報が、IEEE 標準の TEDS テンプレートに準拠していない場合は、正しい情報を読み取り表示を行うこと

はできません。 

 

1. メイン画面のツールバーアイコンの          をクリックします。 
 

 

 

 

 

 

 

 

 

 

 

2. TEDS ダイアログが表示されます。 
TEDS トランスデューサを接続後、LX 本体を立ち上げた場合は、起動時のキャリブレーション時に自動的に TEDS 情報が読み

込まれ、この画面は表示されず、次の Update ボタンがクリックされた画面となります。 
 

 

 

 

 

 

 

 

 

3. Update をクリックすると、アンプに接続された TEDS 対応のトランスデューサの情報を読み込みます。 
TEDS トランスデューサを接続後、LX 本体を立ち上げた場合は、起動時のキャリブレーション時に自動的に TEDS 情報が読み

込まれ、この画面となります。 
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4. Update TEDS information メッセージが表示されますので、OK をクリックします。 
各チャネルに接続された TEDS 対応のトランスデューサの、校正感度(sensitivity)、物理量単位(unit)、シリアル番号
(serial)、製造者名(manufacturer)、校正日付(cal date)が一覧できます。 
 

 

 

 

 

 

 

 

 

読み取られた感度情報を係数として感度設定を行うチャネル番号の左のボックスをクリックして、チェック状態にします。 

 

 

 

 

 

 

 

 

 

 

5. OK をクリックすると、チェックされたチャネルの感度値に対応した値(読み込まれた感度値の逆数)がヘッダファイルの
SLOPE の値として記録され、ダイアログが閉じられます。メイン画面のチャネルプロパティリストを開いて、チェックされたチャ

ネルの SLOPE の値が更新されていることを確認します。 

(「5-16 チャネルのプロパティ」参照) 

 

 

 

 

 

 

 

 

 

チェックボックス 
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オートオフセット 
LX Navi のオートオフセット機能は、オートオフセットボタンがクリックされたときの状態を計測し、そのときの電圧値をオフセット値と

して自動的にヘッダファイルに記録する機能です。オフセット値が設定された場合は、LX Navi のモニター表示は、この電圧値で

Y軸のゼロオフセットを行い波形データ表示します。 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの         をクリックします。 
 

2. Channel Unit テーブルが表示されます。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. オフセットを行うタイミングで、Channel Unitテーブルの Auto Offsetをクリックします。そのときの各チャネルの電圧値が測
定され offset フィールドに表示されます。 
 

4. チェックボックスがチェックされたチャネルに対して、表示されているオフセット値で設定を行う場合は、OK をクリックします。
Confirm ダイアログが表示されます。 
オフセット値を表示されている値に更新するときは、[はい(Y)]をクリックします。 
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実入力によるキャリブレーション 
PA アンプでは、キャリブレータまたはピストンホンを用いて接続されたセンサの実校正係数を自動設定することができます。 

 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの         をクリックします。 
 

2. Channel Unit テーブルが表示されます。 
 

 

 

 

 

 

 

 

 

 

 

 

 

3. Calibration をクリックします。 
 

4. Cal. Sound/Vibration ダイアログが表示されます。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. キャリブレーション終了後、Exit をクリック、または       をクリックしてメイン画面に戻ります。 

 

 

 

 

チャネルを選択します。 

キャリブレーションを行うセンサの

種類を選択します。 

キャリブレーションを RMS値で行う 

か Peak 値で行うかを選択します。 

使用するキャリブレータに合わせて出

力レベルを選択します。 

キャリブレーションを実行します。 

キャリブレーションの進行状況が表示されます。 

キャリブレーション結果を校正係数として反映します。 
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ゼロバランス 
ST アンプでは、電源を入れるたびにゼロバランスをとってください。 

 

 

1. LX 本体が停止状態のときに、ツールバーアイコンの         をクリックします。 
 

2. Zero Balancing ダイアログが表示されますので、ゼロバランスを実行するＣＨにチェックを入れ”Execute”ボタンを押すと 
ゼロバランスを開始します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. ゼロバランスの実行が終了すると下記のダイアログが表示されます。 
 

 

 

 

 

 

 

 

4. 各チャネルのゼロバランスの結果が”State”の項目に表示され、正常なら”OK” 異常なら”NG” が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. ゼロバランス終了する場合は、Exit をクリック、または       をクリックしてメイン画面に戻ります。 
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ＲＸ

ＬＡＮ

SERIAL NO.

MADE IN JAPAN

タコメーターパルス入力の設定 
LX-20/20Lでは、アナログ入力チャネルとは別に、タコメーターパルス用にA,B 2つの入力チャネルを備えています。タコメー

ターパルス入力用の BNC コネクタはリアパネルにあります。 

タコメーターパルス入力チャネルでは、16 ビットモード、または 32 ビットモードのいずれかの選択が可能です。16 ビットモード

が選択された場合は、A､B両方のタコ入力チャネルが使用できます。32ビットモードではA､Bいずれかのチャネルを選択し

使用します。 

なお仕様については、6 章を参照して下さい。 

 

■ タコメーターパルス入力チャネルは、16 ビットモードのときは、 タコメーターパルス入力 １チャネルが アナログ入力 １チ

ャネル分に、32 ビットモードのときは、タコメーターパルス入力１チャネルがアナログ入力 ２チャネル分に相当します。タコメー

ターパルス入力チャネルを ON とした場合、同じアナログ入力チャネル数の記録を確保するためには、選択されたタコメータ

ーパルス入力チャネルに応じて、サンプリング周波数を低く設定します。 

 

■ 102.4 kHz、 100 kHz、96 kHz、 65.536 kHz、 51.2 kHz、 50 kHz、48 kHz、または、32.768 kHz サンプリング周波

数選択時Moving Averageは[1]以外は設定しないで下さい。 
 

■ 102.4 kHz、100 kHz、96 kHz、または、65.536 kHz サンプリング周波数を選択しタコメーターパルス入力チャネル 32 ビ

ットモードで使用する場合は、1 x タコメーターパルス入力チャネルのみ使用可能です。 

 

■ LX Navi ではタコメーターパルス入力チャネルを波形表示することはできません。入力値をモニターする場合はディジタ

ル表示画面を開いてディジタル値でモニターを行なって下さい。〔5-17 参照〕 

 

■ 記録されたタコメーターパルス入力の信号を再生することはできません。ディジタルデータとして処理して下さい。 

 

■ タコメーターパルス入力とジェネレータ出力機能を同時に使用することはできません。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

タコメーターパルス入力部 
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System ダイアログで、Tacho と表示されたタブをクリックしてタコメーター入力チャネルの設定を行います。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

使用するチャネルにチェックをつけ、16bit または 32bit を選択します。それぞれのチャネルに異なるビット数を選択することはでき
ません。設定できるその他のパラメータは次の内容です。 

 

設定項目 (ただし、前述の制限事項にご注意下さい。) 

設定項目 内容 

Measurement  計測モード 

pulse (gate) ゲート時間内のパルス数カウントモード 

pulse (total) 計測のスタートからストップまでのトータルカウント 

Period 周期カウントモード 

Frequency 周波数計測モード 

Rpm 回転数計測モード 

Range  測定レンジ 

pulse (gate) モード時 サンプリング周期の 1～255 倍 

period モード時 1m、5m、10m、50m、100m、500m、1 sec 

frequency モード時 10、20、50、100、200、500、1k、2k、5k、10k、20 kHz 

rpm モード時 1500、3000、6000、9000、12000、15000、18000、24000 rpm 

Threshold Level スレショルドレベル設定 +0.5、+1、+2.5、+5、+10、+20 V 

Divide Rate 分周比設定 1～255 

Moving Average 移動平均設定 1～16 

Pulse per Rev. 一回転あたりのパルス数 1～255 
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出力アンプの設定 
System ダイアログで、出力アンプが取り付けられているスロットのタブをクリックして出力レンジを設定します。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

出力レンジの設定 

出力レンジは 1 V から 5 V まで 0.1 V ステップで選択することができます。 

 

■ 低速サンプリングモード(1 kHz ～ 1/60 Hz)で記録時、出力アンプからのアナログ出力は使用できません。 

 

■ 低速サンプリングモード(1 kHz ～ 1/60 Hz)で記録されたデータファイルのアナログ再生は、1.5 kHz 以上のサンプリン

グ設定に変更して行うことができます。 

 

■ チャネル拡張を行い入力アンプが複数存在する場合には、必ず Output Slot で出力するスロットを必ず設定して下
さい。 

 

■ LX シリーズでは、入力レンジの±100%が、AD 値で±25000 に相当します。ここで設定された出力レンジを±100%と

して記録された入力信号の AD値に対応する電圧の出力を行います。 

例えば、入力レンジ 1 V、出力レンジ 2 V の設定で+1Ｖの信号を入力し記録、再生すると+2Ｖが出力されます。 

 

 

出力レンジの選択 

出力を行う対象の入力ア

ンプスロットの選択 
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トリガ動作のあらまし 
マニュアル操作による以外に、次のようなモードで自動的に記録を開始・停止させることができます。 

 

リピートモード 
下図のような記録動作を指定回数だけ繰り返します。１回だけの記録も可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

〈記録開始条件〉 

■ レベルトリガ 

指定チャネルのレベル変化をトリガとします。 

■ 外部トリガ 

背面の EXT TRIGGER IN コネクタが L レベル（0.6 V 以下）になると開始します。記録待機状態になった時にすでに L レベルで

あった場合は、メモリー記録、メディア記録ではすぐに開始します。PC 記録の場合は記録待機状態になった後に H から L に変

化して初めて記録開始します。 

■ タイムアウト 

指定した記録開始条件が一定の時間内に成立しなかった場合に、強制的に記録を開始します。 

■ プリトリガ 

上記の記録開始条件が成立する前のデータもバッファにたくわえて記録します。この期間はメモ音声は録音されません。 

 

<記録停止条件〉 

■ レベルトリガ 

指定チャネルのレベル変化をトリガとします。 

■ 外部トリガ 

背面の EXT TRIGGER IN コネクタへの接点信号が H レベル（オープンまたは 2 V 以上）になると停止します。 

■ 記録時間 

指定時間だけ記録します。 

■ ポストトリガ 

上記の記録停止条件が成立してからも、一定時間記録を続けます。 

 

 

■ トリガ動作をさせるにはトリガの設定

後、ツールバーの●ボタンをクリック、また

は本体の REC ボタンを押して記録待
機状態にして下さい。 

■ トリガ動作を有効に設定しても、ツ

ールバーまたは本体のボタンは無効には

なりません。 

開始 停止 

プリトリガ ポストトリガ 

記録開始条件成立 

レベルトリガ 

外部トリガ 

タイムアウト 

記録停止条件成立 

レベルトリガ 

外部トリガ 

記録時間 
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インターバルモード 
指定時刻に記録を開始・停止することを指定回数だけ繰り返します。１回だけの記録も可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3 回繰り返しの例) 

開始 停止 

指定記録時間

指定時刻 

指定ポーズ時間 指定記録時間 指定記録時間指定ポーズ時間 

開始 開始 停止 停止 
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リピートモードの設定 
トリガ動作の設定は Setup メニューから Trigger を選択して行います。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例ではレベルトリガで記録開始し、外部トリガで記録停止します。10 秒のプリトリガを指定してあり、記録回数は１

回です。 

 

Pre/Post 
プリトリガまたはポストトリガを有効にする場合にチェックします。ここをチェックして下の Repeat をチェックしないでおくと、ツールバ
ーまたは本体のボタン操作による記録開始に対してプリトリガが有効になります。（ツールバーまたは本体のボタン操作による記

録停止に対しては、ポストトリガは無効です。） 

 

Start PreTrig/Stop PostTrig 
プリトリガ/ポストトリガの長さを秒またはスキャンの単位で指定します。単位を切り替えるには右のボタンをクリックします。「0」に

設定すると無効になります。メモリーの空き容量から可能な時間を超えないように設定して下さい。 

 

 

 

 

秒⇔スキャンの切り替え 

プリ/ポストトリガを有効にする 

プリトリガの長さを指定 

レベルトリガで記録開始 

リピートモードを有効にする 

外部トリガで記録停止 

繰り返し回数 

レベルトリガの設定(次ページ) 

記録時間の設定 
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Repeat 
リピートモードを有効にする場合にチェックします。 

 
Start Condition 
記録開始条件を指定します。複数の条件を指定すると、それらのうちいずれか先に成立した条件で記録開始します。 

Level: レベルトリガを有効にする場合にチェックします。レベルトリガの詳細は Level Trig - Property をクリックすると現
れるダイアログで設定します。（次ページ） 

External: 外部トリガを有効にする場合にチェックします。 
Timeout: レベルトリガ、外部トリガを有効にした場合、指定の記録開始条件が一定の時間内に成立しなかった場合
に、強制的に記録を開始します。その時間を秒の単位で設定して下さい。「0」に設定すると無効になります。 

 
Stop Condition 
記録停止条件を指定します。複数の条件を指定すると、それらのうちいずれか先に成立した条件で記録停止します。 

Level: レベルトリガを有効にする場合にチェックします。レベルトリガの詳細は Level Trig - Property をクリックすると現
れるダイアログで設定します。（次ページ） 

External: 外部トリガを有効にする場合にチェックします。 
RecTime: 記録開始から指定時間後に停止します。その時間はここをクリックすると現れるダイアログで設定します。設
定するとここに時間が表示されます。 

 

■ 外部トリガ信号を記録スタートトリガ、さらに REC TIME を使用してリピート記録する場合には、次のスタートの前に、

一旦トリガ信号レベルを H状態にして下さい。 

 

Repeat Count 
以上で設定したトリガ記録動作の繰り返し回数を指定します。指定した回数分のファイルができます。１回だけの記録も

可能です。「0」に設定すると無限回（手動で停止するまで繰り返し）の設定になります。 
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レベルトリガの設定 
レベルトリガの詳細は Trigger ダイアログで Level Trig - Property をクリックして設定します。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例では、第 2 チャネルの入力信号が指定した入力レンジの＋50％より低い方から高い方向にクロスし、なおかつ第

3 チャネルの信号も同様に＋50％より低い方から高い方にクロスした時に記録開始し、第 2 チャネルの入力信号が指定した入

力レンジの－20％より高い方から低い方にクロスした時に停止します。 

 

チャネルの選択 

チャネルのリストから希望のチャネルをクリックします。または、下のドロップダウンリストから選択します。 

 

クロス方向の選択 

Up: 入力信号が指定レベルより低い方から高い方にクロスした時に条件成立とみなします。記録待機状態にした時にすでに
指定レベルを超えていた時は成立と見なしません。 

Down: 入力信号が指定レベルより高い方から低い方にクロスした時に条件成立とみなします。記録待機状態にした時にすで
に指定レベルを下回っていた時は成立と見なしません。 

Ignore: レベルトリガの監視対象チャネルになりません。 
 

レベルの設定 

指定した入力レンジのフルスケールをプラス側、マイナス側それぞれ 100％とし、それに対する監視レベルを－99～＋99%の範囲

で設定します。マイナスの値には符号「－」をつけて下さい。上図の例では入力レンジが±10 V レンジの場合、50％は+5 V、－

20％は－2 V に相当します。 

 

ロジック 

Start、Stop のそれぞれで複数のチャネルを監視対象にした場合に、それらの AND をとるか OR をとるかを指定します。 
 

条件成立回数 

上記で指定した条件（ロジックを含めて）が何回満たされたら成立と見なすかを指定します。 

ロジックの切り替え 条件成立回数 

設定するチャネルをクリック 

ここでもチャネル選択可能 

クロス方向の選択 

レベルの設定 
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インターバルモードの設定 
トリガ動作の設定は Setup メニューから Trigger を選択して行います。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上図の設定例では、2001 年 8 月 15 日正午から、毎正時から 5分間記録することを 4 回繰り返します。 

 

Interval 
インターバルモードを有効にする場合にチェックします。 

 

Start Time 
インターバル動作を開始する日時を指定します。 

 

Rec Time 
記録時間を、ここをクリックすると現れるダイアログで設定します。設定するとここに時間が表示されます。 

 

Interval Time 
記録と記録の間の待機時間を設定します。（記録動作の周期ではありません。）ここをクリックすると現れるダイアログで設

定します。メディア記録の場合は 3 秒以上に、メモリー記録/PC 記録の場合は 1 秒以上に設定して下さい。設定すると

ここに時間が表示されます。 

 

Repeat Count 
記録動作の繰り返し回数を指定します。指定した回数分のファイルができます。１回だけの記録も可能です。「0」に設定

すると無限回（手動で停止するまで繰り返し）の設定になります。 

 

インターバルモードを有効にする 

インターバル動作開始日時 

記録時間 

ポーズ時間 

繰り返し回数 
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設定の保存と読み込み 
Setup メニューの System、Trigger で設定したパラメータをファイルとして保存し、必要なときに読み込むことができます。
Setup メニューから Params Property を選択すると、下図のダイアログが現れます。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

設定を保存する 
設定したパラメータをファイルとして保存します。ファイルの拡張子は「.prm」です。不測の事態に備えて保存することをおすすめし

ます。 

 

1. Params Property ダイアログで Save をクリックします。 
 

2. 保存先として LXを選択した場合(LX本体に挿入されたメディア)は、LX Parameter File Listダイアログが表示されます。
パラメータ保存を行うファイル名を下部に入力、または保存内容の変更を行うファイル名を選択して、OK をクリックします。 
 

 

 

 

 

 

 

 

2. 保存先として PC を選択した場合は、<名前を付けて保存>ダイアログが表示されます。保存先とファイル名を指定して[保
存(S)]をクリックします。 

 

■ 設定ファイルはテキスト形式ですのでワードパッドなどのアプリケーションで開くことができますが、書き換えないで下さい。書き

換えると読み込めなくなることがあります。 

 

 

設定の読み込み 

設定の保存 

システム設定情報 

チャネルごとの 

設定情報 

設定パラメータファイルの 

読み込み先、保存先の選択

読み込まれたファイル名の表示 
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設定を読み込む 
保存した「.prm」ファイルを読み込みます。 

 

1. Params Property ダイアログで Load をクリックします。 
 

2. 読み込み先として LX を選択した場合(LX 本体に挿入されたメディア)は LX Parameter File List ダイアログが表
示されます。パラメータの読み込みを行うファイル名を選択して、OK をクリックします。 
 

 

 

 

 

 

 

 

読み込んだファイルのファイル名が Params Property ダイアログに表示されます。 
 

3. 読み込み先として PC を選択した場合は、<ファイルを開く>ダイアログが表示されます。読み込み先とファイル名を指
定して[開く(O)]をクリックします。 

 

読み込んだファイルのファイル名が Params Property ダイアログに表示されます。 
 

4. Params Property ダイアログで OK をクリックします。 
読み込んだファイルの内容で LX 本体が設定されます。 

 

 

 

 

 

 


